Microchip Studio ile Arduino MEGA Kartinin Programlanmasi

(Version 1.0)

Bu dokiiman ile birlikte gelen “avrdude.zip” dosyasinda bulunan “avrdude.conf” ve “avrdude.exe”
dosyalarini uygun bir klasére ¢ikartiniz. Bu dosyalari donem boyunca silmeyiniz, bulunduklari dizini
degistirmeyiniz!
Arduino MEGA kartini -konnektdérlerinde herhangi bir jumper kablosu bagl olmadigindan emin
olarak- bilgisayarinizin bir USB portuna takiniz.
“Aygit yoneticisi” ni aginiz. “Baglanti noktalari (COM ve LPT)” altinda bulunan Arduino MEGA 2560
kartinin COM port numarasini bir kenara not ediniz (3. adimda kullanilacaktir.). Asagidaki goriintide
bu deger 3'tir.
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Microchip Studio’yu aciniz. Tools -> External Tools menisiinden “External Tools” penceresini aginiz.
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Asagida “External Tools” penceresinin ilk acildigi hali bulunmaktadir.

Menu contents:

[Mew Tool 1] Add
Delete
|
Aowve
ove Do
| Tetle [New Taol 1]
Command:
Arguments: b
Initial directorny: »
[) Use Qutput window [ Prompt for arguments
Treat output as Unicode B Close on exit
oK Cancel App

Bu pencerede “Title” kismina dilediginiz bir adlandirma yapiniz. Ornegin “ProgramMega”

“Command:” kismina 0. adimda zip dosyasindan ¢ikarttiginiz “avrdude.exe” nin PATH’ini belirtmeniz
gerekmektedir. “...” butonuna tiklayarak “avrdude.exe” yi gosterebilir veya bilgisayarinizdaki duruma
uygun sekilde manuel olarak PATH’i yazabilirsiniz.

“Arguments:” kismina yazacaginiz argimanlar “avrdude.exe” programi ¢alistirilirken ona génderilen
parametrelerdir. Bu kisma asagidaki ifadeyi bilgisayariniza uygun sekilde degistirerek yazmaniz
gerekmektedir. Asagida tek satira sigmamis olsa da, tiim ifadeyi gerekli degisiklikleri yaptiktan sonra
ilgili kisma tek satir olarak yaziniz. Bu ifade manuel yazmaniz durumunda olusabilecek hatalar
engellemek adina “Arguments.txt” dosyasinda verilmistir.

-C"C:\avrdude\avrdude.conf" -patmega2560 -cwiring -P\\.\COM3 -b115200 -D
-Uflash:w:"$ (ProjectDir) Debug\$ (TargetName) .hex": 1

Yukaridaki ifadede yapmaniz gereken 2 degisiklik sunlardir:

i. C:\avrdude\avrdude.conf ifadesini, sisteminizde avrdude . conf dosyasini nereye
cikartmissaniz (0. adim) ona gore uygun sekilde degistiriniz.
ii. COM port numarasini 2. Adimda kenara not ettiginiz degerle degistiriniz.

NOT: ifadenin en basinda yer alan -C parametresinin avrdude . conf dosyasinin hangi diskte
oldugu ile bir alakasi yoktur; onu degistirmeyiniz!



Asagida “External Tools” penceresinin “OK” butonuna basmadan 6nce olmasi gereken durum
verilmistir. Arguments kismina giris yaptiktan sonra, “Close on exit” in segili olmadigindan ve “Use
Output window” un secili oldugundan emin olunuz.

External Tocls [ b 4

Menu contents:

Add
Delete
Mave Up
Move Down
Title: ProgramMega
Cemmand: Chavrdudetavrdude.exe
Argurnents: -C'Chavrdudehavrdude.conf” -patmega2560 -cv  »
Initial directory: »
B Use Output window [ Prompt for argurnents
[ Treat cutput as Unicode Close on ext
OK Cancel Apply

“OK” tusuna basiniz. Ayarlar saklanarak “External Tools” penceresinin kapanacaktir. Artik “Tools”
mendusiinde “ProgramMega” seklinde yeni bir secenek goreceksiniz.
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Artik yeni bir proje olusturarak kodunuzu yazip derleyerek, programinizin karta yiklenmesini
saglayabilirsiniz. Bunun icin yeni proje olusturup kodunuzu derlemek Gzere su adimlari takip ediniz:
i. File->New -> Project menusiine tiklayiniz.
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ii.  Acilan pencerede sol tarafta “Assembler” secili oldugundan emin olunuz. Projenize “Name:”
kismindan dilediginiz bir isim veriniz ve “Location:” kismindan projenizin kaydedilmesini
istediginiz klasorl belirtiniz (Proje adinda ve kaydedilecegi dizinde Tiirkce karakter
bulunmamasina 6zen gosteriniz.). “OK” butonuna basiniz.

New Project 7%
b Recent Sort by:  Default B Search Installed Templates (Ctrl+E) P~
4 Installed Tyne: Assernbl
AVR Assembler Project Assembler ype: Assembler
ChCes Creates an AVR 8-bit Assembler project
Assembler

Micrechip Studio Solutien

Name: AssemblerApplication]
Location: C:\Mikroislemciler2025\ -
Solution name: AssemblerApplicationT Creste directory for solution

iii.  Yeniagcilan “Device Selection” penceresinde “ATmega2560” | secip, “OK” butonuna basiniz.

(“Search for device” kismina 2560 yazarak diger mikrodenetleyicilerin listeden ¢ikmasini
saglayabilirsiniz. Ancak soldaki listeden “ATmega2560” a yine de tiklamaniz gerekmektedir.)

Device Selection X
Device Family: All = Search for device

Name App./Boot Memory (Kbytes) Data Memory (bytes)EEPROM (bytes Device Info:

ATmegal69P 16 1024 512 Device Name: ATmega2s

ATmegal69PA 16 1024 512 Speed: A

ATmegal6A 16 1024 512 Vee: N/A

ATmegal6HVA 16 512 256 Famil: T

ATmegal6HVE 16 1024 512 amiy: mega

ATmegal6HVBrevE 16 1024 512 Device page for ATmeqa2560

ATmegaleM1 16 1024 512 Datashest

ATmegal6U2 16 512 512

ATmegalbU4 16 128 512 Supported Tools

ATmega2560 256 8192 4006 ® AmeLICE

ATmega2561 256 8192 409

ATmega2564RFR2 256 32768 8192 “» AVR Dragon

ATmega236RFRZ 256 32768 2192 + AVR ONE!

ATmega3?2 2 2048 1024 B EDRG

ATmega3208 2 4096 256 [

ATmega3209 32 4096 256 X EDBG MSD

ATmega324a 2 2048 1024 ® AVRISP mkll

ATmega324P 2 2048 1024 B, JTacices

ATmena3?4ph 32 2048 1024



Vi.

Yeni projeniz olusturularak main.asm dosyasi asagidaki sekilde acilacaktir. Burada verilen
assembly komutlari default olarak gelmektedir.
] Assemblerapplication1 - Microchip Studio
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main.asm H X
l;

AssemblerApplicationl.asm

Created: 15.1@.20825 13:25:37
Author : fatih

; Replace with your application code

start:
inc rlé
rjmp start

main.asm agilmazsa asagida verilen Solution Explorer penceresinden agabilirsiniz.
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=4] Output Files
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Kodunuzu derlemek icin mentlerden “Build -> Build Solution” a tiklamaniz gerekmektedir.
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: Clean Solution
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; AssemblerApplicationl.asm Rebuild AssemblerApplication
3 Clean AssemblerApplicationl
; Created: 15.18.2825 13:28:)

3 Author : fatih Batch Build...

3

Configuration Manager...

; Replace with your application code
start:

inc rie

rimp start




Asagidaki goriintlide verilen yesil licgen Run butonu derleme icin kullaniiMAMAKktadir. Ona basip derleme
yapmaya calismayiniz. Bu butonu daha sonra fakli amaclarla kullanacagiz.

E AssemnblerApplication] - Microchip Studio
File  Edit View  VAssist{ Project Build Debug Tools Window  Help

- |alﬁ' 'C'Hd"|3£|]7 | - = | P Ml Debug -
S | Pt @ He B @

main.asm + X
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3 AssemblerApplicationl.asm

3 Created: 15.1@.20825 13:28:37
; Author : fatih

; Replace with your application code

start:
inc rié
rjmp start

vii.  Asagida basaril bir derleme sonrasi igin ekran goriintisi verilmistir. Default gelen kod
hatasiz derlenmektedir. Ancak siz kendi kodunuzu yazarken Output kismindaki olasi hatalara
dikkat ederek gerekmesi durumunda diizletmeleri yapiniz.
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: 4 AssemblerApplicationl
b = Dependencies
b [ Labels
5 Replace with your application code b =4 OutputFiles
start: ) main.asm
inc ri6

rimp start

4 »
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Assembly complete, @ errors. @ warnings
Done executing task "RunAssemblerTask”
Done building target "CoreBuild” in project "AssemblerApplicationl.asmproj”.
Target "PostBuildEvent” skipped, due to false condition; ('$(PostBuildEvent)' != '') was evalusted as ("' != '')

Target "Build” in file "C:\Program Files (x86)\Atmel\Studio\7.@\Vs\Avr.common.targets" from project "C:\Mikroislemciler2825\AssemblerApplicationl\AssemblerApplicationl\Assembler
Done building target "Build” in project "AssemblerApplicationl.asmproj”.
Done building project “AssemblerApplicationl.asmproj”.

Build succeeded.
=====-==-= Build: 1 succeeded or up-to-date, @ failed, ® skipped =====-====

Qutput

viii.  Artik kodunuzu derlediniz. Adim 5’e gecebilirsiniz



5. 0. Adimdan 3. adim sonuna kadar olan islemleri eksiksiz hallettiyseniz ve kartiniz hala USB portuna
bagli ilse “Tools -> ProgramMega” ya tiklarsaniz, projenize ait derleme sonrasi olusturulan .hex
dosyasi kartiniza aktarilarak programlama islemi gergeklestirilecektir.
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start:
inc rl6 ProgramMega
rjmp start External Tools...

Import and Export Settings...
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Asagida basarili bir sekilde programlamanin saglandigini gosteren ekran goriintisi yer almaktadir.
Bu ¢iktida herhangi bir hata olup olmadigini kontrol ederek, hata varsa gerekli diizeltmeleri yapip,
kodunuzu tekrar derleyip ondan sonra programlamaya ¢alisiniz.
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; Replace with your application code
start:

inc rie

rimp start
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2 meinasm
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Show output from: | Programhega e | &z

avrdude.exe: reading input file "C:\Mikroislemciler2@25\Assemblerapplicationl\AssemblerApplicationl\DebugiAssemblerApplicationl.hex”
avrdude.exe: writing flash (4 bytes):

writing | | 1eex @.e4s

avrdude.exe: 4 bytes of flash written

avrdude.exe: verifying flash memory against C:\Mikroislemciler2825\AssemblerApplicationl\AssemblerApplicationl\Debug\Assemblerapplicationl.hex:
avrdude.exe: load data flash data from input file C:\Mikroislemciler2825\AssemblerApplicationl\AssemblerApplicationl\Debug\AssemblerApplicationl.hex:
avrdude.exe: input file C:\Mikroislemciler2@25\AssemblerapplicationliAssemblerApplicationl\Debug\Assemblerapplicationl.hex contains & bytes
avrdude.exe: reading on-chip flash data:

Reading | | 1eex @.e3s

avrdude.exe: verifying ...
avrdude.exe: 4 bytes of flash verified

avrdude.exe: safemode: Fuses OK (E:FF, H:DB, L:FF)
avrdude.exe done. Thank you

I -

4 4

Qutput




6. Yukaridaki ayarlamalari yapip kodunuzu Arduino MEGA 2560 kartina basarili bir sekilde
yazabildiyseniz; ilerleyen zamanlarda farkli uygulama ders saatlerinde programlama islemi igin
yapmaniz gereken bazi 6nemli islemler sunlardir:

i.  Farkh bir Arduino MEGA kartini takmaniz durumunda COM port numarasi degisecektir. Bunu
anlamak icin “Aygit yoneticisi” ni aginiz. “Baglanti noktalari (COM ve LPT)” altinda bulunan
Arduino MEGA 2560 kartinin COM port numarasinin “External Tools” menusiindeki
“Arguments:” kismindaki ayarla uyusup uyusmadigini kontrol ediniz.

ii. Eger COM port numarasi degismisse buna uygun sekilde “Arguments:” kismindaki ifadedeki
COM port numarasini diizeltiniz.

iii.  “avrdude.conf” ve “avrdude.exe” dosyalarini 0. adimda nereye c¢ikardiysaniz, o dosyalarin
orada oldugundan emin olunuz ve donem boyunca silmeyiniz, bulunduklari dizini de
degistirmeyiniz!

MACOS Kullanicilari igin yukaridaki ayarlar gegerli degildir. Clinki Microchip Studio MACOS
bilgisayarlara kurulmamaktadir. Su sekilde kod yazip derleyip karta aktarabilirsiniz:

brew install avra

brew install avrdude

Yukaridaki iki komutla avra ve avrdude kurulumunu yapiniz. Microchip Studio MacOS'ta ¢alismadigi
icin islemleri tamamen komut satirindan yapacagiz.

deneme . asm dosyasini derlemek istiyorsak; bunun igin 6ncelikle bu dosyanin en Ust satirinda
.include "m2560def.inc"

ifadesinin eklenmis oldugundan emin olmalisiniz. Microchip Studio’da proje olustururken 2560’
secebiliyoruz; ancak burada asm dosyasinda bu include'u yapmamiz gerekmektedir. Ardindan
derleme icin:

avra deneme.asm

komutunu vermelisiniz. Derleme basarili ise deneme . hex dosyasi asm dosyasi ile ayni dizinde
olusmus olmahdir.

deneme . hex dosyasini karta yiklemek icin de karti bilgisayara bagladiktan sonra:

avrdude -D -p m2560 -c wiring -P /dev/cu.usbmodem14101 -b 115200 -U
flash:w:deneme.hex:1i

seklinde bir komutu vermelisiniz. Bu komutta " /dev/cu.usbmodem14101" kismi kartin bagh
oldugu port bilgisini icermektedir. Sisteminizde bu kisim degisecektir.



